
Lab 5: Acoustic Signals and the Heart

I. Background
A. For background on the cardiac exam, read the attached handout entitled "The Heart Exam—Chest Auscultation," 

courtesy of Dr. Ptak.
B. For a brief audio/visual tutorial of heart sounds, visit the following website:

http://www.blaufuss.org/
Then click on the "START" button next to "Heart Sounds Tutorial."
 

II. Introduction
A. In this lab, you'll hear and "see" acoustical signals and learn how to interpret them. You'll apply various 

transformations to them and measure sound frequencies. Finally, you'll apply this knowledge to heart sounds, both on 
a sample of normal and abnormal heart sound recordings and then on your own heart.

B. Objectives for this lab:
1. Understand frequency and period of periodic and quasi-periodic signals
2. Observe the effects of high-pass and low-pass filters and how to use them to analyze a signal
3. Understand heart sounds and compare the acoustical and electrical signals generated by your own heart

 
III. Materials

A. Headphones
1. You'll use these throughout the first part of the lab so that the room doesn't become impossibly noisy.
2. Pass them amongst your lab group members so that everybody can hear the signals being studied.

B. Tuning fork
1. This is a tuning fork which is designed to oscillate at a given frequency (printed on the base of the fork).
2. To avoid damaging the tuning fork, don't bang it against anything hard. You can strike it against your hand or 

against the carpeting on the lab bench.
C. Earplugs

1. These are foam plugs that you can use to block noise in an ear.
2. To use an earplug, compress or roll it into a thin rod and insert it into your ear. Then wait. The earplug will gradually 

expand to fill the passage in your ear canal.
D. Vernier microphone

1. This is a simple microphone whose output can be read by Logger Pro.
2. The microphone should already be outfitted to one ear of the stethoscope.

E. Stethoscope
1. This is a standard medical stethoscope which has been modified so that one earpiece is now connected to a 

microphone whose input goes directly into the computer.
2. To use the stethoscope, place the earbud into your ear so that it is angled toward the front. The other ear of the 

stethoscope, with the microphone attached, should be draped over your other ear.
3. The other end of the stethoscope is the one that goes against your chest. There are two sides you can listen with: 

the diaphragm (the wide plastic-covered side) and the bell (the smaller, hollow side, with a hole in the middle). The 
chestpiece of the stethoscope swivels around the tube to accommodate the two different sides:
a. When listening using the bell, the hole at the center of the bell should align with a hole in the tubing underneath.
b. When listening using the diaphragm, turn the chestpiece all the way in the other direction until it "clicks" into 

place. When it is in the correct position, you should be able to hear in the earpiece very loudly when you barely 
touch the diaphragm with your finger.

4. The diaphragm is better for listening to high frequencies; the bell is better for low frequencies.
F. Vernier EKG probe
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1.

2. The EKG sensor plugs into one of the sockets on the left side of the LabPro. It has three alligator clips, colored red, 
black, and green.

3. To connect the EKG to yourself in order to monitor your heart's electrical activity:
a. If you are wearing long sleeves, roll them up past your elbow. If you are wearing a short-sleeved shirt 

underneath, it may be more comfortable to just remove your overshirt entirely for this part of the lab.
b. With a dry paper towel or alcohol swabs, scrub your bare skin in the following locations:

(1) inside of right wrist
(2) inside of right elbow
(3) inside of left elbow

c. The goal is to remove dead skin and oil so that the electrodes can make good electrical contact with your skin. 
Once the appropriate areas of skin have been cleaned off, peel off three electrode patches and stick one to each 
area.

d. Clip the alligator leads from the EKG sensor to the tabs on the three electrode patches as shown.

Black goes on your right wrist, green on your right inside elbow and red on your left inside elbow.
4. If you are interested in more detailed information about the EKG sensor, each work station has a copy of the 

technical manual for the sensor.
 

IV. Procedure
A. Tell us who you are!

1. Take a photo of yourselves using Photo Booth and paste it below:

 
2. Tell us your names:

a.
b.
c.

B. Use Audacity to explore acoustic signals and filtering
1. Audacity is a freeware computer program for editing and manipulating sound. You will find it on the computer dock; 

the icon looks like this: 
2. How to use Audacity

a. Here is a screenshot of the Audacity user interface:
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b. Audacity works with one "project" at a time. Each project can have one or more audio tracks. There are two 
tracks in the screenshot above, entitled "Ahh sung" and "Triangle." The second track, "Triangle," is the currently 
selected track.

c. The buttons at the top control the playing and recording of sound:

Beginning  Play   Record  Pause    Stop     End

Also, in the lower left corner of the window, Audacity will display the function of any button as you mouse over it.
d. If an interval is selected, that interval will be played. If there is no interval selected, the entire duration will be 

played. To select an interval, just click an drag over the region you want on one track or multiple tracks.
e. These buttons control editing and zooming:

        Cut         Copy        Paste        Trim      Silence
                                                      outside     inside

       Undo    Redo          Zoom   Zoom Zoom to  Show
                                          in        out   selection    all

f. Here are the track controls. Use the pull-down menu to rename a track. Click on the X in the upper left to delete a 
track.

Mute prevents a track from playing when you press Play. If Solo is selected, all non-Solo tracks are muted. The -/
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+ slider controls the volume of that track; the L/R slider controls the balance. To the right, the waveform of the 
track is displayed.

g. To add an empty track, go to the Project menu and select New Audio Track. To add a copy of the currently 
selected track, type Apple-D or go to the Edit menu and select Duplicate.

h. To work with the selected interval of a track, use the Effect menu. There are many effects you can apply, but the 
ones we will be most interested in are:
(1) Amplify: this takes a quiet section of the track and makes it louder.
(2) High-pass filter/Low-pass filter: these work just like the filters you learned about in the previous part of the 

course. There is no physical resistor or capacitor, of course, but the signal is modified exactly as if there 
were. You can set the cutoff frequency, f = 1/2πRC, that you want the filter to have. Input signals that are at 
the cutoff frequency are reduced by half; inputs that are much higher (for a low pass) or lower (for a high 
pass) than the cutoff frequency are reduced by much more than half.

(3) Feel free to play around with any of the other effects—there are lots of them, and by and large, they do what 
you might think. You can always undo the effect by clicking on the Undo button or typing Apple-Z.

i. The other thing you can do with the selected interval is overwrite it with a standard waveform (sine wave, square 
wave, or sawtooth wave). To do this, go to the Generate menu and select Tone. You will be asked to select which 
of the three tones to generate, the frequency of the tone (in Hz), the amplitude (in arbitrary units; the maximum 
amplitude is 1), and the duration. By default, the duration is the same as the duration of the selected region. If 
you use this operation on an empty track with nothing selected, you can pick any duration you want.

3. Open Audacity, and the program will create a new empty project. In the lower left corner of the Audacity window, 
where it says Project rate, click on the 44100 and change it to 96000 Hz.

4. Period and frequency of a sine wave
a. From the Project menu, select New Audio Track. In this new track, generate a sine wave of frequency 262 Hz 

(this corresponds to middle C, for those of you who are musicians). Choose an amplitude of 1 and a duration of 
5 seconds. Listen to the sine wave (pass the headphones around so everyone in the group can listen to it). 
Rename this track "Sine."

b. Zoom in on a small region of the waveform until you can actually see the peaks and troughs of the sine wave. 
The scale right above the wave form gives you the time coordinate in seconds. When you have zoomed far 
enough, you can calculate the period of the waveform.
(1) Period = 
(2) Is this consistent with the known frequency of the sine wave?

 
5. Test the limits of your hearing

a. Select one group member to be the "subject" of the hearing test and have him or her wear the headphones and 
stand behind the computer screen.

b. Turn the computer volume all the way up. Mute the 262 Hz sine wave, and zoom out until you can see the entire 
selection.

c. Now create a new audio track. In this new track, generate a sine wave of frequency 20 Hz, amplitude 1, and 
duration 5 seconds.

d. Press Play and see if the subject can hear the 20 Hz sine wave (it may sound like a low rumbling). If not, select 
the entire 5 seconds of the track and generate a sine wave of frequency 25 Hz, and repeat the test. Continue in 
this manner until the subject can hear the tone. If you can hear it at 20 Hz, try it next at 15 Hz. In this way you 
can determine the lowest frequency that you can hear. Record your result here:
(1) Name of subject: 
(2) Lower limit of hearing = 

e. Now test the upper limit in the same way. Generate a sine wave of frequency 15 kHz and test the subject 
(anybody should be able to hear this). Increase the frequency 1 kHz at a time until the subject can no longer 
hear the high-pitched sound. Audacity maxes out at 20 kHz; if you can hear that, you're doing just fine.
(1) Name of subject: 
(2) Upper limit of hearing = 

f. Feel free to test more than one person's hearing, if you like.
g. It may interest you to know that you will lose the upper range of your hearing as you age—it happens to 
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everyone. This is the basis of downloadable ring tones for teenagers that their parents can't hear. It is also the 
reason why some store owners have speakers in front of their store broadcasting very loud high-frequency 
signals, which annoy young people enough that they won't loiter at storefronts, but are inaudible to grownup 
customers.

6. Looking at square waves
a. Delete the track you were using to test hearing, and add a new track called "Square." In it, generate a square 

wave of frequency 262 Hz, amplitude 0.3, and duration 5 seconds. Listen to this tone (pass the headphones 
around so that everyone can hear it).
(1) Qualitatively, how does the sound compare with the sine wave of the same frequency? (You should still have 

the 262 Hz sine wave track in your project. You can listen to one at a time by using the Mute or Solo button.)
 

(2) Zoom in until you can see the square waveform and measure its period. Is it the same as it was for the sine 
wave?
 

b. Zoom back out to the entire track. Select the square wave track and Duplicate it so that you have a third track to 
play around with. Apply low-pass filter to this track with a cutoff frequency of about 300 Hz. Using Solo, listen to 
just this filtered track.
(1) How does it sound different from the unfiltered square wave?

 
(2) Zoom in until the waveform becomes visible. How does it look different from the unfiltered square wave? 

 
(3) Paste a screenshot (type Control-Shift-Apple-4) of the waveform here:

 
(4) Apply the same filter again. Listen and look. Is the twice-filtered square wave more similar to the original 

square wave, or to the sine wave?
 

c. Duplicate the original square wave track again and apply a high-pass filter with a cutoff of about 1 kHz. Play it 
(solo) and listen.
(1) What does it sound like?

 
(2) Zoom in. What does it look like? Paste a screenshot here:

 
(3) What can you conclude about the difference between a square wave and a sine wave of the same base 

frequency?
 

7. Looking at some heart sounds
a. Now delete all of the square and sine wave tracks, and unplug the headphones. From the Project menu, select 

Import Audio.... Look in the "Heart Sounds" folder and find the file called normalheart.wav and import it. This file 
contains an audio recording of a normal heartbeat, with some filtering to remove noise.

b. Listen to the heartbeats. You should hear a repeated "lub-dub" sound. The "lub" is called S1 and the "dub" is 
called S2. Measure the time between S1's and use it to calculate the frequency of the signal (i.e. heart rate):
(1) time between an S1 and the next S1 = 
(2) frequency of beats in Hz = 
(3) Heart rate in beats per minute = 

c. Now look at a single S1. It looks like just a blip, but zoom in very close on it. You should see some actual 
structure—not quite a sine wave, but definitely something which looks somewhat periodic, at least for a few 
oscillations.
(1) Estimate the period of these very fast oscillations:

 
(2) What is the dominant frequency of the signal which comprises the "lub" sound?

 
(3) Is this frequency related to the heart rate you calculated above?
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d. Try applying a high-pass filter to S1 with a cutoff frequency of about 3-4 times the frequency you found in the 

previous part. Is there any signal left?
 

e. Now go back and zoom in on an S2.
(1) How does the waveform look compared to an S1?

 
(2) Does it appear to be roughly the same frequency as the S1?

 
f. Mute the normal heart and import another audio track from the "Heart Sounds" folder, this time choosing 

diamondshapedsystolicmurmur.wav. Listen to the heartbeat and look at the waveform.
(1) How does it sound different from the normal heart sound?

 
(2) Select the interval corresponding to the murmur and amplify it (Effect → Amplify). Now Duplicate the track 

and try filtering the murmur interval with high- and low-pass filters at various frequencies. What can you say 
about the frequency spectrum of the murmur noise (e.g. how does it compare to the spectrum of the S1 or 
S2 noise)?
 

g. When you are finished with this part, quit Audacity by typing Apple-Q. You do not need to save your Audacity file.
C. Listen to your heart with a stethoscope

1. Open the file Lab5.cmbl in Logger Pro.
2. Select one group member to be the "patient" (and also the doctor, since you will be listening to your own heart). Put 

on the stethoscope with one earbud in your ear and the other attached to the microphone. You may want to use an 
earplug in your other ear to damp out surrounding noises.
IMPORTANT NOTE: the equipment you'll be using in this part of the lab is for educational purposes only. It is not 
intended to be used for medical diagnosis. So as paranoid as you might be, don't assume that you have a heart 
disorder based on anything you measure in the physics lab. This isn't real medical equipment, and you're not a real 
doctor. Chances are, you are perfectly healthy. 

3. Using either the diaphragm or the bell side of the stethoscope (your choice, but make sure that the chestpiece is 
turned the correct way for the side you are listening with), find your heartbeat and listen to it. Record the sound in 
Logger Pro by collecting data for a few seconds. If you don't see an audio signal, check the setting on the 
stethoscope.
a. Patient's name:

 
b. Paste a screenshot of your heart sound here:

 
c. Identify the S1 and S2 on your heart signal (there will be more noise than in the heart sounds you saw in 

Audacity). Zoom in close on an S1 and estimate the frequency the same way you did for the normal heart sound 
in Audacity.
(1) Estimated frequency of S1 sound = 
(2) Select the time interval corresponding to S1 and try to fit a sine wave to the acoustic signal. (The fit will not 

be great, of course, since the amplitude isn't very constant, but you can at least get an idea of the frequency 
this way.) What is the frequency from the fit?
 

(3) Does this agree with your other estimate of frequency? (Hint: do you need to think about a factor of 2π 
here?)
 

d. Do the same thing for S2:
(1) Estimated frequency from period = 
(2) Estimated frequency from fit = 
(3) Does S2 overall look similar to S1 or substantially different?
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4. Record your heartbeat again, except this time, while the recording is occurring, knock on your sternum with your 
knuckles a few times.
a. What do the knocks look like in the waveform? Paste a screenshot:

 
b. Zoom in on a knock and measure the frequency of the knocking noise in the same way you did for S1 and S2.

(1) Estimated frequency from period = 
(2) Estimated frequency from fit = 

c. How do these frequencies compare to the S1 and S2 frequencies? What do you think it is about your anatomy 
which is responsible for this frequency?
 

5. Now turn to page 2 of the Logger Pro file. Connect the "patient" with EKG leads as described in the materials 
section. This time, record both your heart sounds (using the stethoscope/microphone) and your heart's electrical 
activity (using the EKG) simultaneously.
a. Paste a screenshot of both graphs here:

 
b. What do you notice about the relative timing of the electrical and acoustical signals?

 
c. Recall the basic elements of a typical EKG from Professor Ptak's lecture:

Can you explain the timing relationship between the EKG signal and the heart sounds? (The second slide of the 
Heart Sounds tutorial at http://www.blaufuss.org/ might help.)
 

d. When you have finished listening to your heart, wipe off the earbud of the stethoscope using an alcohol swab so 
that the next person has a clean stethoscope.

6. Give every member of your lab group a chance to be the "patient." You don't have to record an EKG for each heart, 
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but at least listen with the stethoscope and record a microphone trace.
D. Some fun things to try if you have time:

Audacity can also record sounds, which you can then play with using various effects (filter, time reversal, etc.). The 
built-in microphone is the little hole right next to the camera at the top of the iMac.
1. Record the sound of a tuning fork held right up next to the microphone and examine its waveform.

a. Does it look more like a square wave or a sine wave?
b. How does it respond to various filters?
c. Calculate the period and frequency and compare it to the frequency printed on the tuning fork.
d. Instead of holding the tuning fork next to the microphone, try placing the round end of the tuning fork directly 

onto the computer casing and recording it. How does it sound different to you? How does the waveform look 
different?

e. Can you generate a tone that is a near-exact match for the tuning fork signal? What about an octave higher or 
lower? What about some other musical interval (perfect fifth, major third, etc.)?

2. Try recording human speech and looking at the waveforms. Compare waveforms from similar sounds (e.g. "sss" vs 
"fff", or "rrr" vs "lll") and see if you can identify the differences in the waveforms.

3. Record yourself saying something and then reverse it and play it back. Sounds weird, doesn't it? (No, Paul is not 
dead.) See if you can "speak backwards" so that it sounds intelligible when reversed.

4. The "Heart Sounds" folder has many other different recordings of various abnormal heart sounds. You might be 
interested in looking at and/or listening to those sounds, especially after you've heard your own heart.
 

V. Conclusion
A. That's all for this week!
B. Submit your lab report online in the usual way.
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